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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:

1. Provide a Superior Customer Experience
• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.

4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.

7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

About this Guide
• Ross Part Number: 7950DR-002-01
• Release Date: March 2, 2026. Printed in Canada.
• Software Issue: 15.0.1

The information contained in this Guide is subject to change without notice or obligation.



Copyright
© 2014 - 2026 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross 
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and 
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior 
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross 
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting 
from the use of the information contained herein.
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Warranty and Repair Policy
Ross Video Limited (Ross) warrants its Media I/O Server systems to be free from defects under normal use and 
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Media I/O 
Server system, contact your regional sales manager.

Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.



If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.

Use of Hazardous Substances in Electrical and Electronic 
Products (China RoHS)
Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613.652.4886
Fax: (+1) 613.652.4425

Email (Technical Support): techsupport@rossvideo.com
Email (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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What’s New
Take advantage of the new features and improvements in Media I/O v15.0.1 to help simplify your workflow. Use 
the topics in this section to learn about important changes in Media I/O v15.0.1.

The following improvements are new in Media I/O v15.0.1:

• Shortcut to the Expanded Configuration Dialog
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Shortcut to the Expanded Configuration Dialog
In the Media I/O Web-based User Interface (UI), you can now use the new ‘Open Expanded Configuration’ 
button to open the Expanded System Configuration Dialog. Easily access the full range of configuration options 
without the need to type in the URL (http://x.x.x.x/phoenix).

Figure 1.1  Displays the Open Expanded Configuration Button

To open the Expanded Configuration Dialog

1. In the Media I/O Web-based User Interface, go to System Configuration.

 The Standard System Configuration Dialog opens.

2. From the menu, select Expanded Configuration and click the Open Expanded Configuration menu.
 The Expanded System Configuration Dialog opens.

 TIP: 
Make sure to bookmark the Standard and Expanded System Configuration Dialog URLs. If you accidentally 
close the Media I/O web-user interface, you can navigate back to the original bookmark, or type the URL 
(http://x.x.x.x/aura). Where the x.x.x.x is the IP or name set by the administrator. 

 NOTE: 
The URL for the Expanded Configuration Dialog has a different suffix (http://x.x.x.x/phoenix).
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Introduction
A Word of Thanks
Thank you for choosing Ross Video Media I/O as your ingest and playout solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly respond to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Media I/O solution from Ross Video. We are confident of your future 
pleasure with your choice.

Yours Sincerely,

Shawn Snider
Vice President of Production Workflow & Cloud Services

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide
The Media I/O Configuration Guide begins after completing the instructions in the Media I/O Installation Guide. 
This guide contains the following chapters that cover the configuration of Media I/O software:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “System Overview” provides a quick summary on what Media I/O provides as a service.
• Chapter 3, “Preparing the Environment” summarizes the initial setup procedures that must be performed 

before configuration of all Media I/O applications.
• Chapter 4, “Configuring Media I/O Engine” describes the configuration process for a Media I/O Engine.
• Chapter 5, “Configuring the Database” describes how to configure the database, and then connect to the 

database from the Media I/O Web-based Interface.
• Chapter 6, “Configuring Media I/O Web-based UI Settings” describes additional configuration steps within 

the web-based User Interface.

If you have questions pertaining to the operation of Media I/O, please contact us at the numbers listed in the section 
“Contacting Technical Support” on page 1–3. Our technical staff is always available for consultation, training, or 
service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Managing Large Projects” in the Media I/O User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important notes, instructions, or features. For example:

 NOTE:
After upgrading Media I/O software, you must obtain feature licenses from Ross Video Technical Support before 
users can access Media I/O features.
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Contacting Technical Support
Technical Support is staffed by experienced specialists ready to assist with any technical question or issue. Ross 
Video maintains support centers around the globe to ensure timely responses. Our primary technical support center 
is located in Ottawa, Ontario, Canada, with additional offices in the United Kingdom (London), Australia (Sydney), 
and Singapore, plus satellite locations in New York City, the Netherlands, and China. As our global presence grows, 
we continue to establish additional locations to better serve our customers.

North America
Our North America support center, located in Ottawa, Ontario, Canada, is open Monday to Friday from 8:30 a.m. to 
6:00 p.m. EST, with 24/7/365 on-call service available after hours.

• Phone: +1-613-686-1557
• Toll-Free (North America): +1-833-859-0499

EMEA
Our EMEA support center is open Monday to Friday from 8:30 a.m. to 5:00 p.m. GMT. After-hours support is 
provided by our North America center.

• International Toll-Free: +800-3540-3545

 If the local support specialist is unavailable, your call will automatically transfer to North America.

Australia
Our Sydney, Australia office is located in Alexandria, NSW, and provides local support during regional business 
hours.

• Local Support: 1300-007-677

If the local support specialist is unavailable, your call will automatically transfer to North America.

Online Support
• Email: techsupport@rossvideo.com 
• Website: Submit a support request at: http://www.rossvideo.com/support/tech-support.html

http://www.rossvideo.com/support/tech-support.html
http://www.rossvideo.com/support/tech-support.html
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System Overview
Media I/O encodes and decodes streams of live or file-based video. It can do this from almost any format you can 
think of to any other format you can think of.

• Flexibility: Every channel can record, play or transcode almost any video format, codec and transport.
• Ease of Use: Flex Channels allow easy switching between countless arrangements and combinations to suit your 

needs.
• Scalability: Start as small as a single channel and grow as large as you need to.
• Reliability: Battle-tested software under active development and backed up by world-class customer support.
• Adaptability: Repurpose or group channels for ingest, playout or transcode as necessary.
• Interoperable: Run on-prem, virtualized or in the cloud, and manage with a modern web-based UI on any 

connected browser.

System Workflow Overview

Figure 2.1  Media I/O Workflow Diagram

Prerequisites
This guide assumes that a Media I/O administrator has already installed and licensed the Media I/O system in 
accordance with the Media I/O Installation Guide.

 NOTE:
Please contact your Ross Video sales representative or Ross Video technical support for assistance with installing 
the required software packages.
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Preparing the Environment
This chapter discusses the following topics:

• Setting up Debug Logging
• Storage Mapping Using Task Scheduler
• Storing Access Information Using Credential Manager
• Media I/O Server Settings
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Setting up Debug Logging
When a crash is undergoing troubleshooting on Windows machines, the development team at Ross Video may 
require a crash dump. A crash dump (also known as a dump file) is a file containing the digital record of a recent 
crash on a machine. By default, these files are not enabled on Windows, so this guide will explain how to enable 
them. Please proceed through the following procedures in order.

To create a Crash Log folder

1. Create a new folder with the name Crash Logs in the C:\ drive. 

To run the Registry Editor

1. Press the Windows key and the R key to open the Run command box.

2. Type the following command and press the Enter key.
regedit

3. Select Yes in the User Control Window pop-up box.

To create the LocalDumps key

1. Navigate to the following location.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting

2. Select the Windows Error Reporting key and create a new key named LocalDumps if it is not there already:

•   Right-click Windows Error Reporting.
•   Select New and then Key.
•   Name the key LocalDumps.

To create registry values in the LocalDumps key

1. Select the LocalDump key and create three registry values as mentioned below.

2. Create a DumpFolder Registry Value

•   Right-click in the blank area on the right side and select New > Expandable String Value
•   Name it DumpFolder
•   Double-click it and enter C:\Crash Logs in the Value data field.

3. Create a DumpCount Registry Value

•   Right-click in the blank area on the right side and select New > DWORD (32-bit) value
•   Name it DumpCount
•   Double-click it and enter 10 in the Value data field.

4. Create a DumpType Registry Value

•   Right-click in the blank area on the right side and select New > DWORD (32-bit) value
•   Name it DumpType
•   Double-click it and enter 1 in the Value data field.

Storage Mapping Using Task Scheduler
In order to use Media I/O with shared storage, you need to mount the storage with the highest privileges.
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To Mount Storage in Task Scheduler

1. In Windows, open the Task Scheduler.

2. Select Create Task.

3. For the Name, enter Mount Storage. Select Change User or Group.
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4. In the Object name, type system and select Check Names.

5. After selecting Check Names, select OK.

6. Check the checkbox labeled Run with highest privileges, then select Windows 2019 from the Configure for 
dropdown.
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7. Select the Triggers tab, then select New...

8. In the Begin the task dropdown, select At Startup. In Advanced Settings, select Delay task for up to 
(random delay) and enter 15 seconds. Select OK.

The Create Task window opens.
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9. Select the Actions tab, then select New...

The New Action window opens.

10. Navigate to the New Action window.

a. Select Browse... then browse through the Windows\System32 directory and select net.exe.

b. In the Add arguments (optional) text box, add the parameters to mount the remote shared storage, 
including the credentials.

Enter an argument that is formatted to match the syntax below, where M is the assigned drive letter and the 
IP address is the UNC path of the remote storage.

Syntax:

M:\\<IP address>\<media folder name> /user:<username> <password>
Example:
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M:\\192.168.0.2\media /user:smb smb
11. Select OK.

The New Action window closes.

12. In the Create Task Window, select OK.
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Storing Access Information Using Credential Manager
The Credential Manager stores the access information to be used by the Task Scheduler when using the SYSTEM 
user.

To Store Access Information in Credential Manager

1. In Windows, open Credential Manager.

2. Select Windows Credentials, then Add a Windows credential.

3. Add a new Windows Credential. Enter the IP of the shared storage, the User name, and the Password.

4. Either restart the server or go back to the Task Scheduler, right-click the task you added, and select Run.
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5. Navigate back to Windows Explorer and confirm that the M Drive is connected.

 NOTE:
If the drive shows as disconnected, it is likely still connected. This is a known issue and is not indicative of user 
error.

Media I/O Server Settings
The Media I/O Server saves configuration settings in the jvm.conf file. The settings to tune are as follows:

• wrapper.java.initmemory —sets the initial java heap size for the Media I/O server.
• wrapper.java.maxmemory — sets the maximum java heap size for the Media I/O server.

 You must retune Media I/O Server settings after each install or upgrade of Media I/O server software.

To tune Media I/O Server settings in the jvm.conf file

1. On the Media I/O Server computer, locate the jvm.conf file in the following folder.

C:\Program Files\Ross Video\Media IO\Web UI\configuration
2. Use a text editor to open and edit the jvm.conf file.

3. In the jvm.conf file, locate the following setting:

wrapper.java.initmemory
4. Replace the default memory value for the wrapper.java.initmemory setting with a tuned value. The tuned 

value for wrapper.java.initmemory depends on the software running on your Media I/O Server computer and 
the amount of RAM installed on the computer. Use the following table to set the wrapper.java.initmemory 
value for your Media I/O system:

Table 3.1  

System RAM
2 GB 4 GB 8GB 12 GB 16GB 32GB

Media I/O Server & 
Database

256 512 1024 1536 2048 4096

Dedicated Media I/O Server 1024 2048 4096 6144 8192 16384
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5. Locate the following setting:

wrapper.java.maxmemory
6. Replace the default memory value for the wrapper.java.maxmemory setting with a tuned value. The tuned 

value for wrapper.java.maxmemory depends on the software running on your Media I/O Server computer and 
the amount of RAM installed in the computer. Use the following table to set the wrapper.java.maxmemory 
value for your Media I/O system:

7. Save the updated jvm.conf file and exit the text editor.

8. Restart the Media I/O service as follows:

a. From the Windows Desktop, press Windows Key R.

b. In the Open box, type services.msc.

c. Click OK.

d. In the Services list, locate and select the Ross Media IO service.

e. Click Restart for the Ross Media IO service.

System RAM
2 GB 4 GB 8GB 12 GB 16GB 32GB

Media I/O Server & 
Database

512 1024 1536 2048 4096 8192

Dedicated Media I/O Server 1536 3072 6147 9216 12288 24576
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Configuring Media I/O Engine
This chapter discusses the following topics:

• Installing Media I/O Engines
• Launching Media I/O Engine
• Configuring General Settings
• Configuring the VDCP Emulator
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Installing Media I/O Engines
The Media I/O Engine installer will install 8 instances for Media IO Engines, a Directory Server, and the Timecode 
Engine. There are two configuration defaults based on whether you are using X1 or X2 hardware:

• For X1 Hardware you can configure up to 1 Engine for UHD or 4 Engines for HD. 
• For X2 Hardware you can configure up to 2 Engines for UHD or 8 Engines for HD.

 NOTE:
The AJA Kona 5, AJA Kona Corvid 88, Matrox DLE5L/4/100/LP/12G, and Matrox DLE5L/8/100/LP/12G 
video cards can all be reconfigured for various I/O configurations. For more information, please contact your 
Ross Video Sales Representative.

Launching Media I/O Engine
To launch a Media I/O Engine for the first time

 NOTE:
This process needs to be done for each Engine that requires configuration, when it is launched for the first time.

1. Go to the following Media I/O Engine folder.
C:\Program Files\Ross Video\Media IO\Engines\01

2. Double-click on the Media IO Server.exe application.

Configuring General Settings
To configure Application Timing

1. Go to Media I/O Menu > Edit > Preferences.

2. Select More.

3. For Global Timing, from the list of settings, select one of the following options based on the appropriate 
frames per second:

•   29.97 fps (SMPTE, 30000/1001)
•   59.94 fps (SMPTE, 60000/1001)
•   25 fps
•   50 fps
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To configure RTC Timing

1. Go to Media I/O Menu > Edit > Preferences.

2. Select RTC.

3. For Global Timing, from the list of settings, select one of the following options based on the appropriate 
frames per second:

•   29.97 fps (SMPTE, 30000/1001)
•   59.94 fps (SMPTE, 60000/1001)
•   25 fps
•   50 fps

To configure Log Settings

1. Go to Media I/O Menu > Edit > Preferences.

2. Select More.
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3. Select Log File Settings.
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4. Select Folder.

5. Select the following Folder for the Engine:
C:\Program Files\Ross Video\Media IO\Engines\ENGINE_#\Logs

Configuring TCP/IP Settings

Each Media I/O Engine needs to be configured to listen in a TCP port. Since there are multiple engines in the same 
server, each Engine needs to be set up differently. Please refer to the table below.

Table 4.1  TCP/IP Settings

Media I/O 
Engine # Control Port

WebSocket 
Port

WebSocket 
Port (SSL) Monitor Port VDCP Port

01 8071 8981 9981 8171 9071

02 8072 8982 9982 8172 9072

03 8073 8983 9983 8173 9073

04 8074 8984 9984 8174 9074

05 8075 8985 9985 8175 9075

06 8076 8986 9986 8176 9076

07 8077 8987 9987 8177 9077

08 8078 8988 9988 8178 9078
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To configure Control Port - TCP/IP Settings (Network Identity)

1. Go to Media I/O Menu > Edit > Preferences.

2. Select Network Identity.

3. Modify the TCP Port following Table 4.1, “TCP/IP Settings,” on page 5. This requires a restart of the 
application.

To configure Control Port - TCP/IP Settings (Web Server)

1. Go to Media I/O Menu > Edit > Preferences.

2. Select More.

3. Select the Web Server tab. Modify the TCP Port following Table 4.1, “TCP/IP Settings,” on page 5. This 
requires a restart of the application.
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To configure the Media Player Status

1. Go to Media I/O Engine Menu > Window > Media Player Status.
A new window will open.

2. Select the + button on the lower right corner.

3. Set the name and device type, then select OK.

•   Device Name: The channel name should match the Channel Letter. (E.g., A. B, etc.)
•   Device Type: STEW
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4. Once created, double-click the Player.

5. Select Setup.
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6. Check the Can do Multi Record option.

•   This option allows the Media IO Engine to take over a Manual Recording when a Schedule recording starts.

7. The settings are displayed in a Tree View, grouped by topic and hierarchy. The settings can be switched to Flat 
View (sometimes called List View) and see the settings as a flat list with numbered items. Only the settings that 
differ from the defaults are stored.

•   MPR Deck
•   Switch to idle mode after x seconds - From 0 to 1 (only for Record Channels)
•   Startup Mode

•   Ingest for Record Channels
•   Idle (SDI, NDI, and SRT)
•   Ingest (2110) (NOTE: When you are setting up ingest for 2110, the Switch to idle mode 

after x seconds setting has to be set to 0.)
•   Playout for Playback Channels

•   Playout (SDI, NDI, SRT, and 2110)
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Configuring Ingest and Output

To configure the Playout Stream (SRT)

The Playout Stream determines the main output stream type. This would typically be an NDI Stream Output.

1. Select the second column (Value) and a popup window will open to select the stream. Select MPEG2TS over 
SRT/TCP/UDP.

2. The configuration for SRT is automatically selected.

3. Double-click on the fifth column (Options) to open the SRT-specific settings.

4. Set the Send Mode to SRT - Listener (Multiple Connections). By Default, Media IO SRT Streaming will 
allow multiple clients to connect. It can be changed to single connection if the workflow requires it.

5. Port is the TCP port that the SRT stream will be licensing. Only TCP ports from 1025 and above should be 
used, as ports 0–1024 are generally reserved for well-known services and system processes.

6. Expand the Transport Stream Options to configure the default timebase and stream encoding.
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•   Timebase (Defines the frame rate of the stream):
•   25 fps

•   Playout FPS Numerator: 25
•   Playout FPS Denominator: 1

•   25 fps
•   Playout FPS Numerator: 50
•   Playout FPS Denominator: 1

•   29.97 fps
•   Playout FPS Numerator: 30000
•   Playout FPS Denominator: 1001

•   59.94 fps
•   Playout FPS Numerator: 60000
•   Playout FPS Denominator: 1001

•   Stream Encoding (For SRT streaming, only H.264 is supported. For audio, only a single PID with a 
stereo track is supported.): 

•   Expand the Stream Encoding tree. By Default, the H.264 codec and audio settings are selected
•   Double-click on the fifth column (Options) to open the Codec-specific settings.
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•   Performance: 1
•   Max Logical CPUs to use: 6
•   Preset (Defaults): HTTP Live Stream (HLS) Profiles (depending on your output and bitrate 

select one from the available options)

•   GOP Size: 75
•   Encoding Buffer Length: 0
•   Live Mode: Enable. Restric re-encoding
•   Slices per Picture: 8
•   Frame Rate Numerator: Same as configured before.
•   Frame Rate Denominator: Same as configured before.
•   Picture Structure: Progressive
•   Bit Rate Mode: Variable Bit Rate (VBR)
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To configure the Playout Stream (NDI)

The Playout Stream determines the main output stream type. This would typically be an NDI Stream Output.

1. Select the second column (Value) and a popup window will open to select the stream. Select TVIO: NDI (2) 
Stream 1.

2. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

3. Double-click on the fifth column (Options). The Video Card specific settings will open.
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•   For Framerate, match it to the application timing configuration.
•   For NDI Output Stream Name, this is the name of the NDI stream that will be available over the network. 

This has to be unique for each Engine running in the system.

To configure the Playout Stream (SDI - AJA Kona 5)

The KONA 5 card can be reconfigured to different I/O configurations. It supports up to 4 bidirectional 12G-SDI 
connections with 16-channel embedded audio (HD/UHD).

1. Select the second column (Value) and a popup window will open to select the stream.

2. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

0 in x 8 out 1 in x 7 out 2 in x 6 out

3 in x 5 out 4 in x 4 out 5 in x 3 out

6 in x 2 out 7 in x 1 out 8 in x 0 out
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3. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Output, select the SDI connector the Engine will use.
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To configure the Playout Stream (SDI - AJA Kona Corvid 88)

The KONA Corvid 88 card can be reconfigured to different I/O configurations. It supports up to 8 HD or SD 
channels in any combination.

1. Select the second column (Value) and a popup window will open to select the stream.

2. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

0 in x 8 out 1 in x 7 out 2 in x 6 out

3 in x 5 out 4 in x 4 out 5 in x 3 out

6 in x 2 out 7 in x 1 out 8 in x 0 out
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3. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Output, select the SDI connector the Engine will use.
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To configure the Playout Stream (SDI - MATROX DLE5L/4/100)

The MATROX DLE5L/4/100/LP/12G card can be reconfigured to different I/O configurations using I/O profiles.

You can change the configuration using mvConnectorConfig.exe (requires a restart).

1. As an Administrator, open a Command Line window.

2. Navigate to the following directory:

C:\Program Files\Matrox DSX-TopologyUtils\drivers
3. Run the following command to obtain the serial number of the Matrox card:

mvConnectorConfig.exe list
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4. Run mvConnectorConfig.exe to load the proper input/output configuration. In the following example, the 
configuration is for 1 input and 3 outputs:

mvConnectorConfig.exe load 
-f=Xmio5Le5ConnectorMapping\Dsxle5lp\dsxle5lp_4_01i03o.pin -sn=A647271

5. In the Media I/O Engine application, select the second column (Value) and a popup window will open to select 
the stream.

6. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

7. Double-click on the fifth column (Options). The Video Card specific settings will open.
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•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Output, select the Label (Letter) connector that the Engine will use. follow the table from the 

start of this procedure.

To configure the Playout Stream (SDI - MATROX DLE5L/8/100)

The MATROX DLE5L/8/100/LP/12G card can be reconfigured to different I/O configurations using I/O profiles.
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You can change the configuration using mvConnectorConfig.exe (requires a restart).

1. As an Administrator, open a Command Line window.

2. Navigate to the following directory:

C:\Program Files\Matrox DSX-TopologyUtils\drivers
3. Run the following command to obtain the serial number of the Matrox card:

mvConnectorConfig.exe list

4. Run mvConnectorConfig.exe to load the proper input/output configuration. In the following example, the 
configuration is for 5 inputs and 3 outputs:

mvConnectorConfig.exe load 
-f=Xmio5Le5ConnectorMapping\Dsxle5lp\dsxle5lp_8_05i03o.pin -sn=A647271

5. In the Media I/O Engine application, select the second column (Value) and a popup window will open to select 
the stream.
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6. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

7. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Output, select the Label (Letter) connector that the Engine will use. Follow the table from the 

start of this procedure.
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To configure the Ingest Stream (NDI)

There is no configuration required for NDI Ingest.

To configure the Ingest Stream (SDI - AJA Kona 5)

The KONA 5 card can be reconfigured to different I/O configurations. It supports up to 4 bidirectional 12G-SDI 
connections with 16-channel embedded audio (HD/UHD).

1. Select the second column (Value) and a popup window will open to select the stream.

2. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

0 in x 4 out 1 in x 3 out 2 in x 2 out 3 in x 1 out 4 in x 0 out
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3. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Video Input, select the SDI connector that the Engine will use.
•   For Audio Input, select the SDI connector that the Engine will use.
•   For Genlock, select External Reference.
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To configure the Ingest Stream (SDI - AJA Kona Corvid 88)

The KONA Corvid 88 card can be reconfigured to different I/O configurations. It supports up to 4 bidirectional 
12G-SDI connections with 16-channel embedded audio (HD/UHD).

1. Select the second column (Value) and a popup window will open to select the stream.

2. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

0 in x 8 out 1 in x 7 out 2 in x 6 out

3 in x 5 out 4 in x 4 out 5 in x 3 out

6 in x 2 out 7 in x 1 out 8 in x 0 out
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3. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Video Input, select the SDI connector that the Engine will use.
•   For Audio Input, select the SDI connector that the Engine will use.
•   For Genlock, select External Reference.
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To configure the Ingest Stream (SDI - MATROX DLE5L/4/100)

The MATROX DLE5L/4/100/LP/12G card can be reconfigured to different I/O configurations using I/O profiles.

You can change the configuration using mvConnectorConfig.exe (requires a restart).

1. As an Administrator, open a Command Line window.

2. Navigate to the following directory:

C:\Program Files\Matrox DSX-TopologyUtils\drivers
3. Run the following command to obtain the serial number of the Matrox card:

mvConnectorConfig.exe list



4–28 • Configuring Media I/O Engine Media I/O Configuration Guide (v15.0.1)

4. Run mvConnectorConfig.exe to load the proper input/output configuration. In the following example, the 
configuration is for 1 input and 3 outputs:

mvConnectorConfig.exe load 
-f=Xmio5Le5ConnectorMapping\Dsxle5lp\dsxle5lp_4_01i03o.pin -sn=A647271

5. In the Media I/O Engine application, select the second column (Value) and a popup window will open to select 
the stream.

6. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

7. Double-click on the fifth column (Options). The Video Card specific settings will open.
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•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Iutput, select the Label (Letter) connector that the Engine will use. follow the table from the start 

of this procedure.

To configure the Ingest Stream (SDI - MATROX DLE5L/8/100)

The MATROX DLE5L/8/100/LP/12G card can be reconfigured to different I/O configurations using I/O profiles.
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You can change the configuration using mvConnectorConfig.exe (requires a restart).

1. As an Administrator, open a Command Line window.

2. Navigate to the following directory:

C:\Program Files\Matrox DSX-TopologyUtils\drivers
3. Run the following command to obtain the serial number of the Matrox card:

mvConnectorConfig.exe list

4. Run mvConnectorConfig.exe to load the proper input/output configuration. In the following example, the 
configuration is for 5 inputs and 3 outputs:

mvConnectorConfig.exe load 
-f=Xmio5Le5ConnectorMapping\Dsxle5lp\dsxle5lp_8_05i03o.pin -sn=A647271

5. In the Media I/O Engine application, select the second column (Value) and a popup window will open to select 
the stream.
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6. Select the fourth column (Configuration) and a popup window will open to select the video frame size.

7. Double-click on the fifth column (Options). The Video Card specific settings will open.

•   For Framerate, match it to the application timing configuration.
•   For Enable CEA708 Closed Captions, select Yes if Closed Captions need to be enabled. If they do not, 

select No.
•   For Genlock, select External Reference.
•   For Video Output, select the Label (Letter) connector that the Engine will use. Follow the table from the 

start of this procedure.
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Configuring the Monitor Stream

Determines the monitor configuration for the Engine. See the image below for the settings that need to be changed.

• For Generate Preview Stream Output, choose YES.
• For Audio Encoder, choose MPEG4-Audio (AAC-LC) "mp4a (Ross Video) Ext”
• For Audio Number of Tracks, choose 2.
• For Audio Channels per Track, choose 1.
• For Preview Stream Out Port, see Table 4.1, “TCP/IP Settings,” on page 5.
• For Web Stream Representation Count, choose 1.
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Configuring the Codec Profiles

To obtain codec profiles

1. Ensure the provided CodecProfiles.zip file is present. If it is not, please contact your Ross Video 
representative.

 NOTE: These codec profiles include the configuration for the HLS proxy.

2. Copy the codec profiles into the following location.
C:\Program Files\Ross Video\Media IO\Engines\engine_#\Media IO Server 
Settings\Media Processing Framework Settings\Ingest Presets

Configuring the VDCP Emulator
To add an emulator

1. Go to Media I/O Engine Menu > Window > Media Player Status.
A new window opens.

2. Select the Emulator Device.

3. Select the + button in the lower right corner. 

4. Set the name and device type, then select OK. 

•   For the Device Name, enter VDCP Emulator
•   For the Device Type, select Omneon via VDCP.
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A new Emulator Setup window opens. 

5. In the Emulator Setup dialog complete the following fields:

a. Enter the File (Recording) Path and Backup Path.

b. Optional: You can also add a Default Path (for Playout and Recording).

c. Enter the File (Recording) Path and Backup Path.

d. Enter the Recording Extension(s). Only accepts valid comma separated values. For example: .mxf, .mp4, 
.mov.

e. Enable any of the following options to apply additional VDCP requirements:

•Force Short ID’s — Select this checkbox to apply the short-ID format. This option has no functional 
effect in the current version.

•Force Long ID’s — Select this checkbox to apply the long-ID format. This option has no functional effect 
in the current version.
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•Debug Protocol Messages — Select this checkbox to enable extended VDCP protocol logging, including 
some timing information.

•Exclusive Control — Select this checkbox to disallow the emulator from controlling the device if the 
device has its own clips loaded.

•Don’t Strip File Extensions — Select this checkbox to include file extensions in VDCP IDs.

•Sony VDCP Tweak — Select this checkbox to apply Sony-specific VDCP adjustments to limit the jog 
step size to 32700 and strike the cue-status flag. 

•Allow File Delete — Select this checkbox to allow the controller to delete IDs and clips.

•Unload Orphaned Clips — Select this checkbox to periodically unload all clips from the device except 
the current foreground and background clips.

•Ignore Cue Duration — Select this checkbox to always play clips to the end.

•Ignore Cue TC-in — Select this checkbox to always play clips from the beginning.

•Extra File Access Check — Select this checkbox to add files from the watched folder only when they are 
stable and not locked.

f. Select OK.

To configure the VDCP emulator

1. Select the Emulator Device that you created.

2. Select Connection to set up the TCP/IP port that the Engine will use to listen for VDCP commands.
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3. Select TCP/IP in the connection type and fill out the TCP port with the information from TCP/IP Table 4.1, 
“TCP/IP Settings,” on page 5.

•   For Recording Extension, this option is set to auto-populate the default extension for VDCP recordings.
•   The Valid Values are mxf, mp4 or mov

4. Select the settings below to enable them:

•   Force Long ID's
•   Sony VDCP Tweak
•   Unload Orphaned Clips
•   Ignore Cue Duration
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5. Drag and drop the emulator into the previously configured channel to link the emulator and the player device. 
Once this is done, a confirmation window will open.
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Configuring the Database
This chapter discusses the following topics:

• Creating the Media I/O Web UI Database
• Configuring Timezone Settings
• Opening the Media I/O Web-based UI for the first time
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Creating the Media I/O Web UI Database
To configure the Media I/O Web UI Database

1. After installing MariaDB 11.4.4 LTS, open HeidiSQL.

2. Select New and create a new Database Connection.

3. Modify the Name, User, and Password of the database connection, then click Open.

4. Right-click on the Database icon and select Create new > Database.
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5. Enter the following database name:

mediaio
Click OK.

6. Once created, the database for mediaio is listed under the Databases icon.
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Configuring Timezone Settings
Before logging into the Media I/O Web UI for the first time, it is required to configure the timezone settings in 
JAVA.

To configure Timezone Settings in the http.conf File

1. Go to C:\Program Files\Ross Video\Media IO\Web UI\configuration. 

2. Open the http.conf file and add the following line:
wrapper.java.additional.42=-Dtimezone=TimeZone

3. For example, for a system that is installed in Miami, the configuration file would look like this:
wrapper.java.additional.42=-Dtimezone=America/New_York

 NOTE: 
For a list of all available timezones by country, go to the following link:
https://en.wikipedia.org/wiki/List_of_tz_database_time_zones

4. After adding the line and saving the file, go to the next procedure before restarting Media I/O Web UI:
“To configure Timezone Settings in the service.conf File”

To configure Timezone Settings in the service.conf File

1. Go to C:\Program Files\Ross Video\Media IO\Web UI\configuration. 

2. Open the service.conf file and under System change the default timezone setting to the following:
wrapper.java.additional.10=-Duser.timezone=America/New_York

3. Under Logging Properties change the default timezone setting to the following:
wrapper.timezone=America/New_York

 NOTE: 
For a list of all available timezones by country, go to the following link:
https://en.wikipedia.org/wiki/List_of_tz_database_time_zones

4. After adding the line and saving the file, restart the Media I/O Web UI.
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Opening the Media I/O Web-based UI for the first time
The Media I/O web-based user interface is only accessible from a desktop computer; you cannot access it from a 
mobile device.

To open the Media I/O Web-based UI

1. Open a supported web browser. 

• Google Chrome™ browser version 51 or greater

2. To open the Media I/O web-based user interface, enter the URL provided by your Media I/O administrator. The 
URL will be structured as follows, where your IP address replaces the placeholder text SERVER_IP: 
http://SERVER_IP/aura
The Log in panel opens.

3. In the Login panel, enter your Media I/O administrator login credentials in the Username and Password boxes. 
The default administrator login credentials are as follows:

• Username — root
• Password — password

4. Click Log In.

 IMPORTANT:
Change the root password on your first login.

 NOTE:
If the database is down or the mediaio database was not created, a message that the system in maintenance 
mode will be shown. Make sure the database is running and the mediaio database was created.
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Configuring Media I/O Web-based 
UI Settings
This chapter discusses the following topics:

• Media I/O Configuration Overview
• Configuring General Settings
• Configuring Role-Based Access Control
• Configuring Nodes and Services
• Configuring Media Management
• Configuring Ingest and Playout Settings
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Media I/O Configuration Overview
The Media I/O user interface has been updated to simplify configuration and expand capabilities directly within the 
user interface. You can view the Standard Configuration dialog and Expanded System Configuration Dialog below.

Figure 6.1   Expanded System Configuration Dialog (left) and Standard System Configuration Dialog (right)

 NOTE:
The term 'Standard' and 'Expanded' are temporary terminology for the System Configuration dialogs, as these 
dialogs will eventually be combined.

Standard System Configuration Dialog

The Standard System Configuration dialog, accessible from http://<x.x.x.x>/aura under the  System 
Configuration menu, remains available for core Media I/O configuration tasks listed below.

• System
› General 

(Database | System License | Metadata Configuration | Export Configuration | Input Configuration | Output 
Configuration | Channel Configuration)

• User Management
› Role-based Access Control 

(Users & Roles, Roles & Permissions, and User Sessions)

To access the Standard Configuration Dialog

1.  Enter the URL provided by your administrator in a supported browser, such as Google Chrome. It should 
match this format:
 http://<x.x.x.x>/aura.

2. In the top right, go to  System Configuration.

The Standard System Configuration menu opens.

Expanded System Configuration Dialog

An expanded System Configuration dialog is now available at http://<x.x.x.x>/phoenix under the  
System Configuration menu. While this dialog appears visually identical to the standard System Configuration 
dialog, it provides access to additional configuration options listed below.
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 TIP: A shortcut button is available in the side menu under System Configuration> General > Expanded 
Configuration. 

• System
› General 

(Database | System License)
› Nodes and Services 

(Nodes | Service Delegation)
• User Management

› Role-Based Access Control 
(Users and Roles | Roles and Permissions)

• Media Management
› Storage
› Watch Folder

• Ingest and Playout 
› Export
› Router
› Codecs
› Transcode Engine

To open the Expanded Configuration Dialog

1. In the Media I/O Web-based User Interface, go to System Configuration.

 The Standard System Configuration Dialog opens.

2. From the menu, select Expanded Configuration and click the Open Expanded Configuration button.

 The Expanded System Configuration Dialog opens in the web-browser.

 TIP: 
Make sure to bookmark the Standard and Expanded System Configuration Dialog URLs. If you accidentally 
close the Media I/O web-user interface, you can navigate back to the original bookmark, or type the URL 
(http://x.x.x.x/aura). Where the x.x.x.x is the IP or name set by the administrator. 
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Considerations with Duplicate Configuration Settings
This separation allows the expanded configuration settings to be accessed when needed, without impacting the 
standard configuration workflow.

 IMPORTANT: There is currently some overlap with the menu options that are present in both Standard and 
Expanded Dialog currently. You must not duplicate configurations for RBAC, Licensing, and Database settings! 

› For Database Configuration and Licensing it is recommended that you use the Standard Configuration menu. 
You only need to add the database and license to ONE Configuration Dialog (Expanded or Standard).

› For Role-Based access control it is recommended to configure settings in the Standard Configuration dialog to 
more conveniently access the User Sessions tab to configure the timeout duration. It is not available in the 
Expanded Configuration menu. You only need to configure RBAC in ONE Configuration Dialog (Expanded 
or Standard).
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Configuring General Settings
You can configure settings for metadata, exports, inputs, outputs, and channels. 

 TIP: These settings can be found from the Media I/O web-interface http://<x.x.x.x>/aura under  
System Configuration > General. 

Configuring the Database Settings [Standard Dialog]
You must first connect Media I/O to the MariaDB database from the Media I/O web-based interface. You will add 
the host connection to connect to the database you configured in the previous chapter.

To add the Database Configuration Settings

1. From the top menu click System Configuration.

The System Configuration Dialog opens.

2. Under System Configuration > General, select Database.

3. To edit the database settings, click Unlock and Make Changes.

4. Under Connection Type, for Driver enter a meaningful name for the driver.

5. Under Database, verify that the Status displays a green checkmark.

6. Set the JDBC URL to your MariaDB connection URL. 
The format should match the following: jdbc:mariadb://<host>:<port>/<database>.

7. Set the Username to root.

8. Set the Password to the default root password.

9. Click the Save button.

Licensing Media I/O [Standard Dialog]
Media I/O must be licensed before the System Configuration features become visible in the User Interface. 
Licensing is performed by a commissioner, and is only required to activate the Media I/O system for the first time. 
Contact your Media I/O administrator if your licenses have not be activated.
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To License Media I/O

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select System License.

3. In the Licensing Server dropdown menu, select Ross Activation.

4. In the Product Key input box, paste the product key provided by Ross Video.

 NOTE: Dashes must be included.

5. Verify that the product key was successfully applied by checking the Status column. The status of the 
following four Media I/O licenses should show as Activated:

› Media I/O
› Maintenance
› Flex Channels
› Concurrent Users

To Deactivate Media I/O Licenses

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select System License.

3. Select the license from the table, and then click the Deactivate button.

4. Click the Save button. 
You can now add a new license, or if you need to reactivate the old one, simply select and click the Reactivate 
button.
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Configuring Metadata Attributes [Standard Dialog]
To create a Metadata Attribute

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > Genpassword

3. eral, select Metadata Configuration.

4. Ensure the Attributes tab is selected, and select the + Create button.

5. Enter the following:

a. Name — Enter a meaningful name.

b. Key Name — The key name is automatically generated.

c. Type — Select a type from the drop-down menu: Single-Line String, Multi-line String, Choice, & Boolean.

d. Description — Optionally enter a useful description.

6. Once the attribute properties are completed, click the Save button.

To edit a Metadata Attribute

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Metadata Configuration.

3. Under the Attributes tab, and select the attribute you wish to edit, and click the Edit button.

4. Make your changes, and select Save.

 If you wish to cancel your changes, click the Back button at the top of the page or close the System 
Configuration - Metadata Configuration dialog. Alternatively navigate to your next destination on the menu.

An Unsaved Changes notification appears to confirm whether you want to save your changes. To cancel, click 
Don’t Save.

To create a Metadata Type

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Metadata Configuration.

3. Select the Metadata Types tab and select the + Create button.

4. In the Name box, enter a meaningful metadata type name.

5. For the list of attributes, select the Display checkbox or Required checkbox to include this Metadata Type for a 
specific attribute. The Display checkbox will appear optional, and the Required checkbox is required and will 
appear with a red asterisk next to it. For example, for the attribute Date Created the metadata type Year is 
required.

6. Click the Save button.
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To edit a Metadata Type

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Metadata Configuration.

3. Select the Metadata Types tab, select the Metadata Type you wish to edit, and then select the Edit button.

4. Modify the name or the selections for the list of attributes, where: the Display checkbox will appear optional, 
and the Required checkbox is required and will appear with a red asterisk next to it. For example, for the 
attribute Date Created the metadata type Year is required.

5. Click the Save button.

Configuring the Export Settings [Standard Dialog]
You can optionally set up Media I/O to export sidecar XML automatically. Sidecar exports allows administrators to 
view live updates of the Media I/O system recordings by viewing the exported XML logs.

To Export Sidecar XML

1. Go to  System Configuration button.

The System Configuration dialog opens.

1. In the left tree view, under  System Configuration > General, select Export Configuration.

2. Check the Export Sidecar XML Automatically checkbox.

3. Enter the Default Folder Path that the sidecar XML will automatically be downloaded to. For example: 
<M:\PAM>

4. Click the Save button.

To view the exported sidecar XML

1. On the admin computer, navigate to the Default Folder Path specified in the “To Export Sidecar XML” on 
page 6–8.

2. Double-click to open the exported sidecar XML file with your preferred editor. For example, Notepad++. 

3. To confirm if the exported sidecar XML is updating with new metadata values, you can close the XML file, 
and then go back into the Media I/O web-based user interface and go to the Clip Viewer to edit any of the 
metadata values. Open the appropriate XML file and confirm that the updated values are present.
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Configuring the Input Settings [Standard Dialog]
Use this page to configure input types, such as HLS 1, SB Input, and etc.

 You cannot edit inputs that are actively in use.

To configure an Input

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Input Configuration.

3. Select the + Create button and enter the following:

a. Name — Enter a meaningful input name.

b. Type — Select a supported input type from the dropdown menu (SDI, 2110, NDI, HLS, or SRT).

• SDI - For the SDI Setup, you must check the Use Router checkbox, and enter the Router Input.
• NDI - For the NDI Setup, you must enter the source URL.
• HLS - For the HLS setup, you must enter a source URL.
• SRT - For the SRT setup, you must enter a source URL.

4. Click the Save button.

Configuring the Output Settings [Standard Dialog]
Use this page to configure output types, such as H264 1080p-5994, AVCi 100M-1080p-5994, and etc.

 You cannot edit inputs that are actively in use.

To configure an Output

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Output Configuration.

3. Select the + Create button and enter the following:

a. Name — Enter a meaningful output name.

b. Storage   — Select one of the configured storage options.

c. Codec — Select a supported codec type from the dropdown menu. For example: AVCi 100M-1080p-5994, 
AVCi 50M-1080p-5994, H264 1080p-5994, H264-Proxy, ProresHQ-1080p-5994.

4. Click the Save button.

Configuring the Channel Settings [Standard Dialog]
Use this page to configure channels, such as Channel A, Channel B and etc.

 You cannot edit channels that are actively in use.
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To configure a Channel

1. Go to  System Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > General, select Output Configuration.

3. Select the + Create button and enter the following:

a. *Letter — Enter a meaningful output name.

b.  Label — Optionally, add a meaningful label for this Channel.

c. *Type — Select a type (Ingest, Playout, or Bidirectional). The type cannot be changed after your settings 
are saved.

d. *IP — Enter the server IP.

e. * Port — Enter the Port.

4. Depending on the channel type, please fill in the following:

• Ingest Configuration — Check the Use Router checkbox, and enter the Router Output.
• Playout Configuration — Enter the IP address and Port number.
• Bidirectional Configuration — For the Ingest Configuration, check the Use Router checkbox, and enter 

the Router Output.

5. Click the Save button.
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Configuring Role-Based Access Control
As a Media I/O administrator, you can configure Role-Based Access Control through the Configuration window of 
Media I/O.

Configuring RBAC Users & Roles [Standard Dialog]
You can add new users and roles under the Role-Based Access Control tab.

To add a new user

1. To open the System Configuration dialog, go to  System Configuration.

2. In the left menu under User Management, select Users & Roles.

3. In the User Properties area, enter the following:

a. Active —Select the checkbox to make a user active in the Media I/O system.

b. Domain — Enter the enter the host or IP address of the domain.

c. Username — Enter the user name.

d. Password — Enter the password.

e. First Name — Enter the first name of the user.

f. Last Name — Enter the last name of the user.

g. Title — Enter the job title of the user.

h. Department — Enter the department of the user role.

i. Email — Enter the email of the user.

j. Phone — Enter the phone number of the user.

k. Mobile — Enter the mobile number of the user.

l. API Key — Select the checkbox to enable the API. If selected you must add the API key below it.

m. API Key — If required, enter the API key.

4. In the User Roles area, search for any roles you wish to add and select the checkbox next to the role to add it. 

 NOTE: 
If the desired role is not available, see “Configuring RBAC Roles & Permissions [Standard Dialog]” on 
page 6–11.

5. Select Add User.

6. Select the Language tab to set a different language for the user. Select Save when the desired language has 
been chosen.

7. Confirm that the User has been added to the list successfully, and that all the properties and roles have been 
configured correctly. To make any changes, select the role, edit it, and select Save.

Configuring RBAC Roles & Permissions [Standard Dialog]
To add a new role

1. To open the System Configuration dialog, go to  System Configuration.

2. In the left menu under User Management, select Roles & Permissions.

3. Select the Add Role button.

4. Under Role Properties, enter the following:
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a. Name — Enter a name for the role.

b. Domain — Enter the enter the host or IP address for the domain.

c. Active — Select this checkbox to activate this role in the Media I/O system. 
NOTE: You must save this role before it will appear in the system.

d. Administrator — Select this checkbox to assign Administrator level privileges to the account.

e. Remotely Assignable — Select this checkbox to make the role remotely assignable.

f. If you did not select Administrator level privileges, then a list of role permissions to choose from appears. 
Select Allow for any of the Role Permissions you wish to apply to the role. You can use the Grant All or 
Deny All buttons to quickly apply permissions to the entire list of Role Permissions.

5. Select Save.

6. Confirm that the role you created is now available in the list of Roles.

Managing User Sessions [Standard Dialog]
You can manage user sessions by setting the session timeout value.

To set the User Session Timeout

1. To open the System Configuration dialog, go to  System Configuration.

2. In the left menu under User Management, select User Sessions.

3. In the User Session Timeout box, enter the duration time (in minutes). You can use the up and down arrows to 
add or subtract by increments of 5 minutes.
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Configuring Nodes and Services
You can configure nodes and service delegation in the Expanded System Configuration Dialog. Nodes and Services 
are only required if you are setting up a High Availability system with a secondary server.

 TIP: The Expanded System Configuration Dialog can be found from the Media I/O web-interface 

http://<x.x.x.x>/phoenix under  System Configuration > Nodes and Services. 

Verifying Nodes [Expanded Dialog]
If you are configuring a High Availability system, the primary and secondary Media I/O servers will appear in the 
list of nodes to the right of the System Configuration menu. You can verify that they are successfully connected by 
confirming that a green checkbox appears next to the server name. Select either primary or secondary server to view 
the full details (name, host, status, peers, active services and assigned services).

 High Availability (HA) setups require that the Media I/O web-based interface is successfully installed on two 
separate admin computers and points to the same MariaDB database. The nodes must be able to communicate 
and appear in the Expanded System Configuration > Nodes and Services > Nodes area before channel 
configuration.

To Verify the Primary and Secondary Server Connections (Only Required for High Availability Setup)

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The Expanded System Configuration Dialog opens.

2. In the left tree view, under  System Configuration > Nodes and Services, select Nodes.

3. You can verify that they are successfully connected by confirming that a green checkbox appears next to the 
server name. 



6–14 • Configuring Media I/O Web-based UI Settings Media I/O Configuration Guide (v15.0.1)

Assigning a Node to a Service Delegation [Expanded Dialog]
You can assign nodes to any of the service delegations that appear on the Service Delegation list.

To Assign a Node to a Service Delegation

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The Expanded System Configuration Dialog opens.

2. In the left tree view, under  System Configuration > Nodes and Services, select Service Delegation.

3. You can select a Service Delegation from the list to the right of the System Configuration menu and then select 
the Assign Node checkbox to assign it to either the Primary or Secondary server node. For example, Asset: 
Delete Asset Services, Asset Ingest Monitor: Asset Ingest Monitor Service, Asset Update Sidecar: Asset 
Update Sidecar Component, LDAP: Background Services, and etc.

4. Click the Save button.
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Configuring Media Management
You can configure media management by adding a local storage system and watch folders.

 TIP: The Expanded System Configuration Dialog can be found from the Media I/O web-interface 

http://<x.x.x.x>/phoenix under  System Configuration > Media Management.

Configuring a Storage System [Expanded Dialog]
You must configure a default local storage system.

To configure a storage system

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The Expanded System Configuration Dialog opens.

2. In the left tree view, under  System Configuration > Media Management, select Storage.

3. To create a new storage, select the + Add button.

4. Fill in the following:

a. *Provider — Enter the provider. For example, FileSystem.

b. *Name — Enter a meaningful name for the storage system. For example, Primary Media Storage.

c. *Namespace — Enter a unique identifier for this storage namespace.

d. *Path — Enter the directory path. For example, M:/MAM.

e. If you wish to enable indexing, select the Enable Indexing checkbox.

When enabled, Media I/O performs a register-in-place operation:

• Existing media files are scanned and registered in the Media I/O database.
• Files are not moved or copied.
• Only supported media formats, frame rates, and file extensions are registered.
• Images and thumbnails are not included.
• Indexing does not generate proxy media.

f. If you wish to enable an initial state scan, select Initial State Scan.

5. Click the Save button.

6. Select the storage you just created.

7. Select the Enabled checkbox to make this storage active.

8. Select the Default checkbox if you wish this to be your default storage.

9. Click the Save button.

Configuring a Watch Folder [Expanded Dialog]
You must configure a watch folder for your Media I/O system.
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To configure a watch folder

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > Media Management, select Watch Folder.

3. To create a new watch folder, select the + Add button.

4. Select the Enabled checkbox.

5. Fill in the following:

a. *Name — Enter a meaningful name for the watch folder.

b. *Path — Enter the directory path for the watch folder. For example, M:/PAM.

c. *Destination Storage — Select the destination storage. For example, Live Ingest Recordings.

d. *Polling Interval — Select the preferred Media I/O polling interval. For example: 10 seconds.

e. Allowed File Extensions — Enter the preferred file extension type, separated by commas. For example, 
.mxf, .mp4, .mov, .avi, .clip.

6. Click the Save button.
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Configuring Ingest and Playout Settings
You can configure the following ingest and playout settings: exports, router, codecs and transcode engines.

TIP: The Expanded System Configuration Dialog can be found from the Media I/O web-interface 

http://<x.x.x.x>/phoenix under  System Configuration > Ingest and Playout Settings. 

Configuring Export Settings for Ingest and Playout [Expanded Dialog]
You must configure the default folder path where you wish the sidecar XML to be automatically exported.

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > Media Management > Ingest and Playout, select 
Export.

3. If you wish to export sidecar XML, select the Export Sidecar XML Automatically checkbox.

4. Add a Default Folder Path to the directory you wish the XML files to be stored.

5. Click the Save button.

Configuring Router Settings for Ingest and Playout [Expanded Dialog]
You can configure router settings in the Media I/O web interface.

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > Media Management > Ingest and Playout, select 
Router.
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3. For the Engine Settings, you must fill in the required field (indicated by a red asterisk):

a. Host — Enter your localhost.

b. Port — Enter the port of the admin computer your engine is installed on.

4. Optionally, if you need to add a router connection enter the following Router Settings:

a. Router Name — Enter the router name.

b. Host — Enter the host IP address.

c. Port — Enter the router port number.

d. Protocol — Select the protocol from the dropdown menu.

e. Levels — Enter a level.

f. Inputs — Select the inputs you wish to use for the router.

g. Outputs — Select the outputs you wish to use for the router. 

h. Automatically Create Input Sources — Select this checkbox if you wish input sources to be 
automatically created.

i. Click the Save button.

To Clear Router Settings

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under  System Configuration > Media Management > Ingest and Playout, select 
Router.

3. Click the Clear Router Settings button.
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Configuring Codecs for Ingest and Playout [Expanded Dialog]
You must configure your codec settings, wrapper type and paste in the appropriate validated JSON file.

 IMPORTANT: Use a JSON formatter or validator on your JSON snippet to ensure correct configuration.

1. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.

2. In the left tree view, under System Configuration > Media Management > Ingest and Playout, select 
Codecs.

3. To add a new codec type, select the  Add button.

4. Fill in the following:

a. *Name — Enter a meaningful name for the storage system.

b. *Wrapper Type — Select the preferred wrapper type from the drop-down menu. For example, MOV.

c. *Codec JSON — Paste the parsed JSON codec file.

5. Click the Save button.

Configuring Transcode Engine Settings for Ingest and Playout [Expanded Dialog]
You must add the Transcode Engine on the admin computer to the Media I/O web-based interface. 

1. Before you begin, verify your Transcode Engine settings on the administrative computer. Navigate to the 
appropriate folder and open the Transcode Engine application. 

2. You can find the Port number under Application Properties > Web Server.

3. Once the Media I/O web-interface for the Expanded System Configuration Dialog is open, go to  System 
Configuration button.

The System Configuration dialog opens.
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4. In the left tree view, under  System Configuration > Media Management > Ingest and Playout, select 
Transcode Engine

5. Click the Add button to add the Transcode Engine.

a. *Host — Enter the host of the Transcode Engine.

b. *Port — Enter the port of the Transcode Engine.

6. Click the Save button.
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